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IntuiLink PSA/ESA-E/L/IEMC-series Spectrum Analyzer Toolbar in Word

What would you like to do?
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Connect to the spectrum analyzer and verify communication
Connect to a spectrum analyzer on a remote host

Capture the current spectrum analyzer settings

Restore previously stored settings to the spectrum analyzer
Edit the name of a saved state setting

Remove saved state settings

Export current spectrum analyzer settings to a PC file
Import spectrum analyzer settings from a PC file

Get an image of the spectrum analyzer display

Delete the spectrum analyzer toolbar from Word

Restore the spectrum analyzer toolbar to Word

Select the toolbar startup options

Disconnect from the spectrum analyzer

% Connect to the spectrum analyzer and verify communication

Make sure that your spectrum analyzer is physically connected to your computer and

turned on.

Click Connect to Spectrum Analyzer on the spectrum analyzer toolbar.

Highlight the address from the Select Instrument Address list for the spectrum analyzer

that you want to connect to.
Note:

Th

e instrument addresses listed are for instruments connected to the computer shown under

the Select Instrument Address list. Look at the label above the Identify Instruments
button. The name will be either "My Computer" or the name or IP address of a remote host. If
you want to change the host computer, press the Advanced button and follow the
instructions in Connect to a spectrum analyzer on a remote host.

Click Identify Instrument(s).

The instrument type, name, and address appear in the Identified Instruments list on the
right. Instruments supported by the software are in bold type.

Tip: You can double-click on the instrument address and the instruments at that address
will appear in the Identified Instruments list.

In the Identified Instruments list, highlight the instrument that you want to connect to.
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Click Connect.

A green icon appears to the left of the instrument that is connected. The corresponding
icon on the toolbar also turns green (after you close the dialog box) to indicate the
instrument is connected.

Tip: You can double-click on the instrument to connect to it.

If you do not know the address, you have two options:

* You can select the address that you think may be correct and click the Identify
Instrument(s) button to determine the type of instrument at that address.

OR

* You can select more than one address (hold down the Shift key while clicking with the
mouse or hold down the CTRL key while dragging the mouse) and click Identify
Instrument(s). All the instruments at the selected addresses are listed, with the instruments
supported by the toolbar in bold.

See the troubleshooting section of the online help if you still cannot connect to the instrument.
See Also
Disconnect from a spectrum analyzer

Connect to a spectrum analyzer on a remote host

% Connect to a spectrum analyzer on a remote host
(Windows NT or Windows 2000 only)

This procedure assumes that you have already installed the PSA/ESA software on the
remote computer and have a spectrum analyzer connected to the remote computer via GP-IB
or RS-232.

Click Connect to Spectrum Analyzer on the toolbar.
In the Connect dialog box, click Advanced.
The Advanced dialog box appears.

Enter the IP address or DNS hostname of the remote computer where the spectrum
analyzer is connected.

Click Add. The hostname or IP address is now listed in the drop-down box under Select
Instrument Address By Host:

From the drop-down list, select the remote host that you want to connect to.
Note:

To list only those instruments connected to your computer, select My Computer from the
drop-down list.



6. Click Close.

In the Connect dialog box, the addresses for the remote host appear in the Select
Instrument Address list, and the host name or IP address is displayed just above the
Advanced button.

Note:

Windows 9x does not support remote instantiation of COM server processes. Visit Microsoft's
Web site and search for the Knowledge Base article #Q165101 for more detail.

ﬁ Capture the current spectrum analyzer settings

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar.
2. Click Capture New ... to capture the current spectrum analyzer state settings.
The Capture New State dialog box appears.
3.  Enter a name for the state settings.
4. Enter a description (optional).

5. Click OK. The information appears in the list in the Capture/Restore Settings dialog box.

Note: The instrument state settings are saved in the document.
See Also
Restore previously captured settings to the spectrum analyzer

Export spectrum analyzer settings to a PC file

ﬁl Restore previously captured settings to the spectrum analyzer

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar.

2. From the list in the Capture/Restore dialog box, select the name of the state settings that
you previously captured.

3. Click Restore.



4. Check the screen on the spectrum analyzer to verify that the settings were restored.
State settings are not tracked between work sessions. Therefore, when you exit this work
session and start the software again, the state settings that you restored in this work session
will no longer be in effect.
Note:

You cannot restore state settings to a different model of spectrum analyzer than was used to
create the original settings file.

See Also
Capture the current spectrum analyzer settings

Import spectrum analyzer settings from a PC file

ﬁ Edit the name of a saved state setting

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar.

2. From the list in the Capture/Restore dialog box, select the name of the saved state
settings that you want to edit.

3. Click Edit Name.

4. Type in the new name for the saved state setting.
See Also
Export spectrum analyzer settings to a PC file

Remove saved state settings

w Remove saved state settings

1. Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar.

2. From the list in the Capture/Restore dialog box, select the name of the saved state
settings that you want to remove.

3.  Click Remove.
The state settings are deleted and are no longer available.
See Also

Export spectrum analyzer settings to a PC file

ﬁ Export spectrum analyzer settings to a PC file
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Click Capture/Restore Spectrum Analyzer Settings on the spectrum analyzer toolbar.

From the list in the Capture/Restore dialog box, select the name of the state settings that
you previously captured.

Click Export.

Navigate to the desired directory on your PC and enter a file name, with the file extension
.sta.

Click Save to store the file.

The file is now saved outside of the toolbar program. Settings are saved automatically within
the document by using the capture feature.

See Also
Import spectrum analyzer settings from a PC file

Capture the current spectrum analyzer state settings

w Import spectrum analyzer settings from a PC file

Click Capture/Restore Spectrum Analyzer Settings from the spectrum analyzer toolbar.
Click Import.

Navigate to the desired directory on your PC and select the previously stored state setting
file (.sta file extension).

Click Open to open the file and download the stored settings to the spectrum analyzer.

From the list in the Capture/Restore dialog box, select the state setting that you just
imported.

Click Restore to restore these settings.

Note:

You cannot import the settings to a different model of spectrum analyzer than was used to
create the original settings file.

You can import files generated with the Agilent Technologies IntuiLink Spectrum Analyzer
product (E4444A).

See Also

Export spectrum analyzer settings to a PC file

[er Get an image of the spectrum analyzer display

Place your cursor in the Word document where you want the image to be displayed.



Click Get Screen Image on the spectrum analyzer.

Click Place in Active Document at Cursor (the default) to place the image in the current
document. An image of the current spectrum analyzer display is placed in the document.

OR
Click Save to File to save the image to a file.
Navigate to the directory in which you want to place the file.
Specify a file format, either .omp, .wmf, .gif, jpg, .emf, or .tif.
Click Save.
Note:

Depending on the type of instrument connection, there may be up to a 10 second delay while
the picture transfers from the instrument.

Delete the spectrum analyzer toolbar from Word

If you want to delete the spectrum analyzer toolbar from the current Word session, follow
these directions.

From the Tools menu in Word, select Templates and Add-Ins.
Clear the check box next to 'ESA.dot’. Make sure that the box is not checked.

Click OK to delete the toolbar.

Alternatively, you can just hide the toolbar.
From the View menu in Word, select Toolbars.
Uncheck the box next to ‘ESA Spectrum Analyzer’.
Note:

When you first install the software, the spectrum analyzer toolbar is automatically loaded
each time you start Word.

See Also
Restore the toolbar to Word

Select the toolbar startup options

Restore the spectrum analyzer toolbar to Word
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If you want to restore the spectrum analyzer toolbar from the current Word session, follow
these directions.

From the Tools menu in Word, select Templates and Add-Ins.
Check the box next to 'ESA.dot’.

Click OK to restore the toolbar.

Or if you have just hidden the toolbar:
From the View menu in Word, select Toolbars.
Check the box next to ‘ESA Spectrum Analyzer’.
Note:

When you first install the software, the spectrum analyzer toolbar is automatically loaded
each time you start Word.

See Also
Delete the toolbar from Word

Select the toolbar startup options

Select the toolbar startup options

When you first install the software, the spectrum analyzer toolbar is automatically loaded
each time you start Word.

Remove toolbar at startup
To prevent the toolbar from loading each time you start Word:

Locate the file named 'ESA.dot' in the following directory:
\ Program Files \ Microsoft Office \ Office \ Startup

Select the above file, click the right mouse button, and then select Delete.
Restore toolbar at startup

If you have disabled automatic loading of the toolbar and now want to re-enable the feature,
follow the steps below:

Locate the shortcut file named 'ESA.dot' in the following directory:
\ Program Files \ Agilent \ IntuiLink \ ESA

Select the above file, click the right mouse button, then select Create Shortcut.



3.

2.

Move the shortcut copy of the file to the Microsoft Office Startup folder:
\ Program Files \ Microsoft Office \ Office \ Startup

% Disconnect from a spectrum analyzer

On many computers, the COM port is alternately shared by several peripheral devices. The
Disconnect feature allows you to terminate your current connection to a spectrum analyzer
without exiting the PSA/ESA E/L/EMC software, freeing up the COM port.

Click Connect to Spectrum Analyzer on the toolbar.

If you are currently connected to a spectrum analyzer, the Disconnect button will be
available. If you are not connected, the button is grayed out.

Click the Disconnect button in the Connect dialog box.
The current spectrum analyzer connection is terminated.
Note:

Connecting to a different spectrum analyzer will disconnect you from the current instrument.
You can be connected to only one instrument at a time.

Connect to Spectrum Analyzer

In this dialog box, you specify the spectrum analyzer to which you want to connect.
Prerequisite

Make sure that your spectrum analyzer is physically connected to your computer and turned
on.

Procedure

Highlight the address from the Select Instrument Address list for the spectrum analyzer
that you want to connect to.
Note:

The instrument addresses listed are for instruments connected to the computer shown under
the Select Instrument Address list. The name will be either "My Computer” or the name or
IP address of a remote host. If you want to change the host computer, press the Advanced
button and follow the instructions below under "To connect to an instrument on a remote
computer".

Click Identify Instrument(s).

The instrument type, name, and address appear in the Identified Instruments list on the
right. Instruments supported by the software are in bold type.



Tip: You can double-click on the instrument address and the instruments at that address
will appear in the Identified Instruments list.

3. Inthe Identified Instruments list, highlight the instrument that you want to connect to.
4. Click Connect.

A green icon appears to the left of the instrument that is connected. The corresponding
icon on the toolbar also turns green (after you close the dialog box) to indicate the
instrument is connected.

Tip: You can double-click on the instrument to connect to it.

If you do not know the address of the spectrum analyzer:

« Select the address you think may be correct and click Identify Instrument(s) to determine
the type of instrument at that address.

OR

* Select more than one address (hold down the Shift key while clicking with the mouse or
hold down the CTRL key while dragging the mouse) and click Identify Instrument(s). All
the instruments at the selected addresses are listed, with the instruments supported by the
toolbar in bold.

See the troubleshooting section of the online help if you still cannot connect to the instrument.
To disconnect from a spectrum analyzer:

If you are currently connected to a spectrum analyzer, the Disconnect button will be
available. If you are not connected, the button is grayed out.

1. Click Disconnect.
The current spectrum analyzer connection is terminated.

To connect to an instrument on a remote computer (Windows NT or Windows 2000 only):

This procedure assumes that you have already installed the PSA/ESA software on the
remote computer and have a spectrum analyzer connected to the remote computer via GP-IB
or RS-232.

1. Click Advanced.
The Advanced dialog box appears.
2. Enter the IP address or DNS hostname of the remote computer.

3.  Click Add. The hostname or IP address is now listed in the drop-down box under Select
Instrument Address By Host:

4. From the drop-down box, select the remote host that you want to connect to.
Note:

To list only those instruments connected to your computer, select My Computer from the
drop-down list.



5. Click Close.
In the Connect dialog box, the addresses for the remote host appear in the Select
Instrument Address list, and the host name or IP address is displayed just above the
Advanced button.
Note:

Windows 9x does not support remote instantiation of COM server processes. Visit Microsoft's
Web site and search for the Knowledge Base article #Q165101 for more detail.
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